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Overview of Digi Embedded Yocto 1.6

This guide is intended for embedded systems developers with previous experience with the Yocto
Project who want to use Yocto with Digi embedded modules. This document will guide you through the
installation and setup of Digi Embedded Yocto, a Linux distribution built upon the Yocto project.

Platforms supported
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Overview of Digi Embedded Yocto 1.6 Platforms supported

Platforms supported

Digi Embedded Yocto 1.6 supports the following Digi embedded platforms:
m ConnectCore 6 SBC

m ConnectCard for i.MX28

It contains two Yocto layers:
1. meta-digi-arm: This layer is based on meta-fsl-arm and contains the BSP customizations for

Digi's supported platforms.

2. meta-digi-dey: This layer adds two new target images to Yocto:
m dey-image-minimal, a minimal busybox command line based image.

= dey-image-graphical, a graphical SATO (a GNOME mobile graphical environment) based
image.
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Developing with Digi Embedded Yocto

There are two distinct development workflows to consider on Digi Embedded Yocto.

System development: When the Digi Embedded Yocto installation generates target images, that is
the U-Boot bootloader, Linux kernel and root file system.

Application development: When the developer is working on a C/C++ user space application that
needs to be run and debugged, which will be integrated in the final images at a later stage.

Setting up your workstation ... ...
Installing Digi Embedded Yocto
Updating Digi Embedded Yocto
Creating ProjeCtS il
Updating existing projects
Configuring projects
BUIlING IMageS ...
Customizing Digi Embedded Yocto
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Developing with Digi Embedded Yocto Setting up your workstation

Setting up your workstation

Your PC workstation must be set up correctly in order to use Digi Embedded Yocto. You will find
instructions regarding supported operating systems and specific OS setup in the Yocto online Quick
Start Guide. Please follow the instructions corresponding to your operating system before continuing.

Installing Digi Embedded Yocto

The repo tool installs Yocto. Download repo to a directory within your path and add execution
permissions.

cur’l http://commondatastorage.googleapis.com/git-repo-downloads/repo > /usr/
local/bin/repo
chmod a+x /usr/local/bin/repo

It is assumed that you are running repo from /usr/local/dey-1.6 (make sure you have user write
permissions).

cd /usr/local/dey-1.6

repo init -u https://github.com/digidotcom/dey-manifest.git -b refs/tags/1.6.9
repo sync -j4 --no-repo-verify
Note that the process above will either qinstall Digi Embedded Yocto for the first time, or upda:

If you are updating from a previous major release like dey-1.4, you must install in a new directory and
re-create your projects.

Updating Digi Embedded Yocto

Digi performs extensive validation testing on the released Digi Embedded Yocto tags (dey-1.6.x).
However, the Yocto community continually updates its stable branches with fixes. If you want to keep
up to date with these changes, sync your installation with the head of the release branch as follows:
repo init -u https://github.com/digidotcom/dey-manifest.git -b daisy
repo sync -j4 --no-repo-verify

Creating projects

The available platforms in the meta-digi-arm layer are:
m ConnectCore 6 SBC, ccimx6sbc

m ConnectCard for i.MX28, ccardimx28js

To initialize the project and environment, we use the mkproject.sh script. For example, for the
ccimxésbc, you should do the following:

mkdir -p $HOME/workspace/ccimx6sbc
cd $HOME/workspace/ccimx6sbc
source /usr/local/dey-1.6/mkproject.sh -p ccimx6sbc

This will initialize the project with a conf directory and two configuration files:
= bblayers.conf: The available layers are configured here.
m local.conf: Local configuration variables affecting only this project are customized here.

The mkproject.sh script sets the environment for the build in the current running terminal. It also
creates a dey-setup-environment script in the project's root folder. This script can be safely rerun over
existing projects to set up the build environment on a new terminal.

Digi Embedded Yocto 1.6 First Steps Guide 7


http://www.yoctoproject.org/docs/current/yocto-project-qs/yocto-project-qs.html#the-linux-distro
http://www.yoctoproject.org/docs/current/yocto-project-qs/yocto-project-qs.html#the-linux-distro
http://source.android.com/source/using-repo.html

Developing with Digi Embedded Yocto Updating existing projects

Updating existing projects
When updating your installation of Digi Embedded Yocto, you will need to erase the tmp and sstate-

cache directories from existing projects and build them from scratch. Leaving the directories intact
may result in problems in the build and the final images.

Configuring projects
Edit the variable MACHINE_VARIANT at file conf/local.conf to configure the project to match your

module variant and hardware components. The conf/local.conf file contains a table describing the
different module variants.

The following example selects a ConnectCore 6 variant that has Wi-Fi, Bluetooth, a Quad/Dual CPU,
and 1024 MiB of RAM:
MACHINE_VARIANT = "wbql1023"

It is important to select the MACHINE_VARIANT that matches your hardware variant. Otherwise,
you may experience the following problems: system images may lack support for some hardware, and
try to load support for non-existing hardware, or prevent the system from booting.

Building images
To build the images, use one of the following commands depending on whether you want a graphical
or command line based file system.
bitbake dey-image-minimal
or
bitbake dey-image-graphical

Note that dey-image-minimal does not support the X11 window system, so in order to build this image
you need to add the following line to the project's conf/local.conf:
DISTRO_FEATURES_remove = "x11"

Generated images, including a bootable SD card image, are in the
<project>/tmp/deploy/images/ccimx6sbc folder.

You can program these images to the module’s internal eMMC, a microSD card, or perform a network
boot using the U-Boot bootloader that was preloaded on the hardware. For more information about
booting the operating system, download the U-Boot Customizations Reference Guide (document
number 90001422) from the Documentation section of the Digi Resources page.

Customizing Digi Embedded Yocto

Configuring default network settings

DEY allows you to configure the default network settings for your target's image which will appear in
the /etc/network/interfaces file. This is done in your project's local.conf file using the following
variables to define your default network settings:

ETHNn_STATIC_IP = "<ip address>"
ETHN_STATIC_NETMASK = "<netmask>"
ETHN_STATIC_GATEWAY "<gateway>"

Where nis 0 or 1 depending on the number of available Ethernet interfaces in your platform.
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Developing with Digi Embedded Yocto Customizing Digi Embedded Yocto

WLANO_STATIC_IP = "<ip address>"
WLANO_STATIC_NETMASK = '"<netmask>"

To configure dynamic IPs, you can use the following configuration:
ETHN_MODE = "dhcp"
WLANO_MODE = "dhcp"

By default, the DEY target images are configured with static IPs.

ETHO_STATIC_IP 7= "192.168.42.30”
ETH1_STATIC_IP 7= "192.168.44.30" (if applicable)
WLANO_STATIC_IP 7= "192.168.43.30" (if applicable)

Adding packages to your target image

If you want to add a package to your image, for example strace, add the following to your project’s
conf/local.conf file:
IMAGE_INSTALL_append = " strace"

Include the space before the word strace.

Adding features to your target image

Apart from the standard Yocto features, the DEY images introduce some new features that allow for a
certain degree of customization ease.
EXTRA_IMAGE_FEATURES = "<feature-name>"

Most of the features are automatically selected based on the selected machine. For example, a
machine that supports ALSA will include the dey-audio feature automatically.

A list of new DEY features follows:
m dey-audio: Adds audio support to a platform.

m dey-gstreamer: Adds the gstreamer framework to a platform.
= dey-network: Adds network applications and tools. You can configure some of the network

applications in your conf/local.conf by doing:

VIRTUAL-RUNTIME_ftp-server = "vsftpd"
VIRTUAL-RUNTIME_http-server = "cherokee"
VIRTUAL-RUNTIME_network-utils = "net-tools"
VIRTUAL-RUNTIME_snmp-manager = "net-snmp-server"
VIRTUAL-RUNTIME_ssh_server = "dropbear"

m dey-wireless: Includes wireless applications and drivers.

m dey-bluetooth: Adds Bluetooth support.

= dey-debug: Adds DEY debugging applications asmemwatch and fbtest.
m dey-examples: Adds DEY example applications.

= dey-qt: Adds QT support for dey-image-graphical. This feature is added by default in dey-
image-graphical images.
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Developing with Digi Embedded Yocto Customizing Digi Embedded Yocto

Advanced customization

When further customization is needed, the suggested way to customize Yocto for your specific need is
to create a new layer. An example of this could be called meta-custom. You can use it directly above
meta-digi-arm, or you can use it to customize the Digi demo images already provided in meta-digi-dey.

Your meta-custom layer can:
= Include new recipes, for example to add new applications to Yocto that compile from source, or
to add new files to the file system.

= Modify existing recipes in any other layer by adding a .bbappend recipe. This is also designed to
modify existing files in the file system.

m Create a new target image.
m Create new machine configurations.

m Provide default kernel configurations or configuration fragments for your new platforms.

Digi Embedded Yocto 1.6 First Steps Guide 10



Using the Eclipse application development

environment

Installing Eclipse

Configuring the Eclipse Yocto plugin
Configuring to use a standalone toolchain
Configuring to use a system derived toolchain
Preparing your DEY project for application development

Creating a project ............._.
Running an example application

Debugging an example application
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Using the Eclipse application development environment Installing Eclipse

Installing Eclipse

The recommended Eclipse version to use with Digi Embedded Yocto 1.6 is the Kepler 4.3 standard
edition. Other versions might work but could lead to unexpected problems.

Download the Kepler tarball and unpack it on a location of your choice.
tar -xzvf eclipse-standard-kepler-SR2-1linux-gtk-x86_64.tar.gz
Start the Eclipse IDE, and check for updates from the Help menu. Then select Install New Software
from the Help pull-down menu, selecting Kepler-download.eclipse.org/releases/kepler.
Install all the updates and the following Eclipse components:
Linux tools
m LTTng - Linux Tracing Toolkit
Programming languages
m Autotools Support for CDT
m C/C++ Development Tools
Mobile and device development
m C/C++ Remote Launch
= Remote System Explorer End-user Runtime
= Remote System Explorer User Actions
m Target Management Terminal
m TCF Remote System Explorer add-in
m TCF Target Explorer

Install the Eclipse Yocto plugin by adding the following repository
downloads.yoctoproject.org/releases/eclipse-plugin/1.6/kepler.

If you experience user interface problems with Eclipse on newer versions of Kubuntu, try changing the
GTK theme to something other than Oxygen.

Configuring the Eclipse Yocto plugin

The Eclipse Yocto Plugin can be used with either standalone toolchains or system derived toolchains -
that is, the toolchain built as part of your Digi Embedded Yocto project.

You can install a standalone toolchain in one of two ways:
m Install the Application Development Toolkit (ADT) installer.

m Install a pre-built Digi Embedded Yocto toolchain.

The ADT installer can be downloaded from the Yocto project web site. It will install a generic ARM
toolchain and sysroot and will allow you to debug using an external soft floating point ARMV5 or
compatible target.

The Digi Embedded Yocto toolchain installs target-specific ARM toolchains and a sysroot that matches
dey-image-graphical. It can be downloaded from Digi's server and can be used to develop both console
or graphical applications. This is the recommended toolchain to install.

To configure the ADT:
1. Goto Windows > Preferences > Yocto Project ADT.

2. Download the Digi Embedded Yocto prebuilt toolchain to a directory of your choice and run it.

For example, for the ConnectCore 6 you would do as follows:
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Using the Eclipse application development environment Configuring the Eclipse Yocto plugin
./dey-eglibc-x86_64-dey-image-graphical-cortexad9hf-vfp-neon-toolchain-1.6.9.sh

It is a good idea to create a platform specific directory if you are going to use toolchains for different
architectures.
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Using the Eclipse application development environment

Configuring to use a standalone toolchain

Configuring to use a standalone toolchain

Cross compiler options

Standalone pre-built toolchain

Toolchain root location

Sysroot location

Target architecture

v

-

v

-

v

-

v

v

-

>

al

General

Ant

C/C++

Help

Install/Update

Java

Plug-in Dewvelopment
Remote Development
Remote Systems
Run/Debug

Target Explorer
Team

Terminal

Tracing
| Yocto Project ADT

/opt/dey/1.6.9/ccimx6sbc

/opt/dey/1.6.9/ccimx6sbc/sysroots/cortexadhf-
vfp-neon-dey-1linux-gnueabii

cortexa9hf-vfp-neon-dey-linux-gnueabi

Yocto Project ADT fe=1RV} v -
Cross development profiles:
ccimxésbc v | |Save as..| |Rename
Remove
Cross Compiler Options:
* Standalone pre-built toolchain
./ Build system derived toolchain
Toolchain Root Location: ’foptfdeyﬁ .6.2/ccimx6sbe 1 Browse..
Sysroot Location: ’,iupt,idey,,"‘! .6.2f/ccimx6sbc/sysroots/cortexadhf-vfp-neon-dey-linux-gnueabi ) Browse..
Target Architecture: [cortexaghf-vfp-neon-dey-Linux-gnueabi w

_ QEMU

Target Options:

Kernel:

Browse..

Custom Option:
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Using the Eclipse application development environment Configuring to use a system derived toolchain

Configuring to use a system derived toolchain

This will use the toolchain compiled in your DEY project.

Cross compiler options

Build system derived toolchain

Toolchain root location ~/workspace/<project>

Sysroot location ~/workspace/<project>/tmp/sysroots/$MACHINE
2O Preferences @ @
type filter text o (@ Please apply the changes to revalidate, oo o ow
b General

Cross development profiles:

b Ant
Standard Profile l'l Save as ... | Rename
b C/C++

b Help Remove

b Installiupdate Cross Compiler Options:

b Java (O standalone pre-built toolchain

¥ Plug-in Development ® Build system derived toolchain

b Remote Systems

b Run/Debug Toolchain Root Location: I]usrflm:a\lday-imx&[wurkspacsfccimx&sbc Browse..
b Target Explorer
Sysroot Location: I,'usrfluca\Iday-lmxﬂlwurkspacs,‘cclmxﬁSbcﬁmp]aysruutsjcclmxﬂsbcl Browse..
b Team
Terminal Target Architecture: [ |
b Tracing Target Options:
Yocto Project ADT O QEMU
Kernel: I Browse,
Custom Option: I
(® External HW
Restore Defaults | Apply |
® Cancel | oK |

Preparing your DEY project for application development

To use the build system derived toolchain run the following in your project:
bitbake meta-ide-support

To build a toolchain installer for the standalone toolchain configuration run the following in your
project:

bitbake dey-image-minimal -c populate_sdk
or

bitbake dey-image-graphical -c populate_sdk

To be able to perform debugging on a remote target you need to run a root file system with the tcf-
agent daemon running. By default, the sdk images (dey-image-minimal-sdk and dey-image-graphical-
sdk) include the tcf-agent. You can also add the agent to your DEY project by adding the following
features to your local.conf:
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Using the Eclipse application development environment Creating a project

EXTRA_IMAGE_FEATURES = "tools-debug eclipse-debug"

Creating a project
File > New > C project > Yocto Project ADT autotools Project

In the following sections, we will use a Hello World ANSI C Autotools sample project, called hello_
world.

Running an example application
1. Build the application. Right click project > Build Project

2. Configure the remote session as follows:
m Open a remote terminal and run ifconfig to get its IP address.

= In Run Configurations, extend the C/C++ remote application to show a hello_world_
gdb_arm-dey-linux-gnueabi remote debug launcher already created for you.

m [f there is no launcher preconfigured, create a new C/C++ remote application with a TCF

(Target Communication Framework).
m Create a new connection to the target’s IP address.

= Fillin the Remote Absolute File Path for C/C++ Application with the absolute pathin
the remote target to copy the application to, for example /hello_world.

Create, manage, and run configurations ~

iEXIBE - Name: |hello_world_gdb_arm-dey-linux-gnueabi

| # ||| B Main . ®= Arguments| & Common

[E] C/C++ Application

Connection: Local A New.. | | B
= [E] C/C++ Remote Applicati

= Project:

ic
& Cclipse Application hello_world Browse...
1 Java Applet Build configuration: Use Active - |
&1 Java Application [ Select configuration using 'C/C++ Application’
Ju JUnik

C/C++ Application:
Ju JUnit Plug-in Test

& Launch Croup
% 0SGi Framework Variables... Search Project... | Browse... |

|5rc[hello_world

[ Remote Application Remote Absolute File Path For C/C++ Application:

8 Target Communication F |/hetloiworld Browse...

Commands to execute before application

=l
Fter s 1. 12 | |
Filter matched 12 of 12 items Apply Revert
@ Run Close |

Then run the configuration. When prompted, the username and password is root/root. You will see the
program output on the console view.
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Using the Eclipse application development environment Debugging an example application

File Edit Source Refactor Navigate Search Project Run YoctoProjectTools Window Help |

M- EBEIR-K - & @ -0 8 | Target Profiles - ! = ! % - @ - @ - % B8 | 4

= I O B % e o [ £y B | & Java [BC/CH
[25 Project Explorer %2 = O | [g hello_werld.c % =0 ®=0R @M = 0
& i @ * Copyright (C) Your copyright.[] = BE W o %
= Zhello_world — #include <stdlib.h> M
b = autom4te.cache #include <stdio.h- o stdlib.h
b 4 Binaries ~int main(void) { u stdio.h
puts("Hello World"); /* prints Hello World */ . .
b @l Includes return 0; e main(void) : int

¥ Esrc ?
b 35 hello_world - [arm/ls
b [y hello_world-hello_w

[ & Makefile

lan| MakeFile.am -

[an MakeFile.in =

[ac aclocal. m4 [ |

|2l arm-dey-linux-gnueabi

Problems ¢ Tasks ‘B Console = Properties @ % % | G BE IE'I@ [t B-5-=8

I AUTHORS <terminated> hello_world_gdb_arm-dey-linux-gnueabi [C/C++ Remote Application] /home/alex/worksp
[Zl autogen.sh root@ccimxBsbe: /#
ho $PWD' >

|2 ChangelLog jg o ¥ ”
= compile root@ccimxBsbe: /# shello_world;exit

. Hello world
[& config.guess Logout
config.h
G| 9 -

I E— 0] [ L1

[¢ /hello_world/src/hello_world.c

Debugging an example application

Configure the remote session as follows:
1. In Debug Configuration, check C/C++ Remote application configuration.

2. Onthe debugger tab, GDB debugger should point to the configured Yocto toolchain.

Create, manage, and run configurations ﬁ\

CExla®p-

i

Name: [hello_world_gdb_arm-dey-linux-grueabi

I & (2 Main [@- Arguments (% Debugger . & Source| £ Common|
C/C++ Application Debugger: remote gdb/mi ~|
[E1C/C++ Attach to Application

[€1C/C++ Postmortem Debugger Stop on startup at: |main Advanced...

~ [€]€/C++ Remote Application Debugger Option

| hello_world_gdb_arm-dey-linux-gnueabi Main | Shared Libraries | Gdbserver Settings|

@ Eclipse Application

5 Java Applet CDB debugger: I/opt/deyﬂ‘6.2/cc\mxésbc/sysroots/x86764—deysdk—l\nux/usr/bm/arm—deyrhnux'gnueab\/arm—dey—Unux'gnueab\—gdb Browse...
[ Java Application CDB command File: |/home/alex/workspace/heuo_world/ adbinit Browse...
Ju JUnit

(Warning: Some commands in this File may interfere with the startup operation of the debugger, For example "run.)

Ji Junit Plug-in Test Protocol: Default [ v

¥ Launch Group [ Use Full file path o set breakpoints
# 0OSGi Framework

E: Remote Application =
Remote Java Application

[ Target Communication Framework

Filter matched 15 of 15 items Using Legacy Remote Create Process Launcher - Select other... Apply Revert
@ close

3. Click the Debug button. The debug perspective appears with the application executed on the

external hardware.
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Using the Eclipse application development environment

Debugging an example application

File Edit Source Refactor Mavigate Search Project Run YoctoProjectTools Window Help

M- BireE o E PR gl -0-Q-ioEaim® P -

-8 -eo-2 o

45 Debug & B ok [ v
< [&] hello_world_gdb_arm-dey-linux-gnueabi [C/C++ Remote Applicati
< &2 gdbserver debugger (11/7/14, 9:40 AM) (Suspended)
< o Thread [1] (Suspended: Breakpoint hit.)
i Remote Shell
i fopt/dey/1.6.2 fccimxBsbc/sysroots/x86_64-deysdk-linux/usr/bin
i /fhome/alex/workspace /hello_world/src/hello_world (11/7/14, ¢

v = g

[¢ hello_world.c &
@ * Copyright (C) Your cepyright.[]

#include <stdlib.h=
#include <stdio.h=

= int main(veid) {

puts("Hello world"); /* prints Hello World */
return 0;

B | &' Java %C/C++_

= Variables ©s Breakpoints i} Registers 2 =4 Modules = g8
LB
Mame |Value
i 12130706036
mir2 2130706044
. ! nnann -
[ L]
= B i Outline ® =8
— E 1R W o % 7
U stdlib.h
U stdio.h

o main(void)  int

[T

(|

B Console 8+ Tasks Problems Executables 0 Memory

Ex % @B 22-0- =0

hello_world_gdb_arm-dey-linux-gnueabi [C/C++ Remote Application] /homefalex/workspace/hello_world/src/hello_world (11/7/14, 9:40 AM)
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